Horseshoe Crab Jeopardy!  International Version
Adapted from:  Garth Stubbolo, Everett Meredith Middle School (Middletown, DE) and Stacy Epperson, MD Dept. of Natural Resources, Aquatic Education Program.  2010.  Green Eggs & Sand curriculum.  by:  Gary Kreamer. 2015.  Delaware Division of Fish & Wildlife, Aquatic Resources Education Program.

Grade Level:  Middle School/High School/College                    
Class time:  one 40-50 minute class period
Materials:  computer, LCD Projector, Horseshoe Crab Jeopardy Power Point, teacher question & answer sheet, chalkboard and chalk (or white board and dry-erase marker) for tallying team scores

Overview:  This activity, provided in PowerPoint format, engages students in “Jeopardy” style game play, to assess their knowledge of various aspects of horseshoe crab (HSC) biology, ecology and uses. Two versions of the game are provided:  one with a general knowledge focus (targeting the student level)  and the other (Double Jeopardy) with more challenging content (aimed at more HSC-savvy audiences).  Clear instructions are also provided for teachers for creating their own versions of the game, including how to change categories, clues, answers and images for adaptation to other audiences and topics.  

Procedure:  
1. Open the HSC Jeopardy.ppt file and select Slideshow mode.
2. Lay out the rules of the game with attention to:  a) raising of hands to provide answers (in question form) to clues (whether anyone from any team can do this, or whether a person is designated hand raiser for each team, and whether hands can be raised before the entire clue is read or only after);  b) order of participation:  team that provides correct answer (in question form) gets to choose the next question from the board, but if answered incorrectly, remaining teams are given chance to try providing the answer/question to that same clue or opt for choosing a different one from the board; c) scoring of dollars earned (not real of course) for answers:  whether to deduct dollars (as in the game show) for incorrect answers/questions or to just add to team totals for the correct ones; and d) agreeing to set time limit for answers (15 seconds?  30 seconds?) or risk forfeiting to other team.  
3. Divide students into no more than 3 teams. Decide which team goes first. That team selects a category and dollar value. The teacher (or assigned student facilitator) clicks on the choice with the mouse.
4. Once the clue statement is read aloud by the teacher (or assigned student game facilitator), hands are raised. The team to raise their hand first has the first shot at the question. 
5. If the answering team is correct (using teacher answer key provided), the teacher (or student facilitator) selects “answer” from the clue slide (calling up the correct answer slide to verify it), then the $ earned score is added to the score on the board.  The game continues by clicking on “return to gameboard” and asking the team to select the next category and clue.
6. If the teacher decides (using answer key provided) that the answer given is incorrect, before the Answer link is clicked, the remaining team(s) are given a chance to answer the question, or they may choose to decline.  If so, play moves on to the next team to select a question from the board.
7. Play continues until all clues/squares have been answered, or time runs out for the class/program. The team with the most $ earned at that point is declared the winner.

Creating different versions of the game:  The instructions to follow are applicable to working with the Windows 10 version of PowerPoint.  Alternative pathways may need to be followed for making adjust-ments for items #2-4 below when working with other Windows and/or MAC PowerPoint versions.
1. Changing categories, clues and answers:  This is the easy part.  To change categories, open up the first slide (showing the gameboard) in Normal View.  Highlight the category heading text, and change it to whatever new category name you wish to create.  Do this for all categories.  Similarly, to change clues and answers, go to the respective slide for each, highlight the text box, delete the old text and type in the new. 
2. Changing background images on slides:  Select the Slide Sorter option from the View menu and drag/click to select the sequence of slides in which you wish to insert a new background image.  Open the Design menu and select Background.  Under Insert from:  click the File button and browse to the folder/file containing the image you’d like to insert.  Once selected, you should see that image inserted into all the slides you selected.  Click the Close button to exit the background pop-up.
3. To lighten or adjust background images:  Should the image you selected be too bold or busy that it interferes with the reading of screen text (but still constitutes a scene or graphic you wish to use), you can experiment with lightening it by going back to the Format Background pop-up (by selecting Background from the Design menu again) and moving the Transparency tab near the bottom of the screen to the right to whatever percentage gives you the desired level of visibility.  Once done, hit Close to exit that pop-up and return to your Slide Sorter view screen for any further adjustments.
4. Changing the location of Daily Double slides:  This is the most challenging of changes to make, so if you don’t need to do it, then let it be - unless you have a class of students with which you use varying versions of the game throughout the year who’ve caught on to where the Daily Doubles fall. To make such changes, you will need to do the following:  in Slide Sorter mode, drag and drop the Daily Double slide to just in front of the clue slide that you want it to cover (that’s the easy part).  Now to the tricky part …  the flow of HSC Jeopardy from gameboard slide to the slide that shows a selected category and dollar/number choice is controlled by a hyperlink embedded in the underlined number of the gameboard slide. So for example (in HSC Jeopardy), when one clicks (in slide show screen format) on the “Where in the World” category at “400”, the hyperlink in place will automatically move the game to slide 8, which brings up the clue slide associated with that choice.  But if the sequence of slides is changed by moving any of the Daily Double slides to new spots, then the sequence of hyperlinks can be thrown out of whack.  To correct that, one needs to go back into Normal View to the gameboard slide, right-click on whichever category/number cell you need to change, select Edit Hyperlink from the pop-up, scroll down through the menu of slide listing options, and make sure that the slide number you wish the hyperlink to navigate to is highlighted.  Once so, hit OK to go back to the gameboard, and continue similar edits of hyperlinks to any other impacted slides. Important note:  there can be a domino effect to making such a change to one slide, resulting in the need to edit links to the sequence of a whole bunch of other slides to follow.  Should you need to do this, it may be helpful to set up a chart - such as those provided on the pages following - to indicate the sequence of slides and hyperlinks for the game, so if any changes need to be made, adjustments to the sequence can be tracked accordingly. Please note:  there is no need to change hyperlinks associated with underlined text (e.g. Question, Answer or Return to  Gameboard prompts on slides, as these are set to advance where they need to go regardless of the slide order).                       

International Horseshoe Crab Jeopardy ppt slides set-up information
	Category
	Value
	Hyperlink    takes you to 
	Question
	"What is" Answer

	1st column (Where in the World?)
	100 
	 Slide 2
	are horseshoe crabs called ‘kabutogani’
	Japan

	
	200 
	 Slide 4
	are the southernmost populations of the American horseshoe crab found
	Yucatan, Mexico                               

	
	300 
	 Slide 6
	are the eggs of HSCs considered a dining delicacy
	Malaysia, Thailand and/or Vietnam

	
	400 
	 Slide 8
	do you need to go to see the largest masses of spawning HSCs on the planet
	Delaware Bay, USA

	
	500 
	 Slide 10 – Daily Double
	are HSCs raised by high school students for release   into the wild to help rebuild populations 
	Hong Kong and/or Taiwan 

	2nd column (By the Numbers)
	100 
	 Slide 13
	number of species of HSCs that exist today
	4

	
	200 
	 Slide 15
	number of long spines on female Tachypleus tridentatus 
	3

	
	300 
	 Slide 17
	number of pairs of legs on a horseshoe crab
	5

	
	400 
	 Slide 19
	millions of years HSCs have been living on Earth 
	450 (445 to be precise)

	
	500 
	Slide 21     
	years it takes an American HSC to reach adulthood
	8-10

	3rd column (HSC Parts Smarts)
	100 
	 Slide 23
	Nobel Prizes were awarded for research carried out on this part of the HSC anatomy
	lateral eyes or  compound eyes

	
	200 
	Slide 25 -Daily Double 
	structures horseshoe crabs use for respiration
	book gills

	
	300 
	 Slide 28
	scientific term for front section of the HSC body 
	prosoma

	
	400 
	 Slide 30
	name used for specially modified hind legs of the HSC
	pusher legs

	
	500 
	 Slide 32
	during spawning, eggs (in females) and sperm (in males) are released from the underside of this HSC structure 
	operculum                               (or gill cover) 

	4th column (Horseshoe Uses)
	100 
	 Slide 34
	much-valued biomedical product from HSC blood
	LAL or TAL

	
	200 
	 Slide 36
	HSC eggs on Delaware Bay provide a key resource             in supporting the migration of _____
	shorebirds                                   (or red knots)

	
	300 
	Slide 38 -Daily Double 
	LAL makes human medicines safe to use by ensuring that they are not contaminated with _____ 
	bacterial endotoxins

	
	400 
	Slide 41 
	from the mid 1800’s to 1900’s, millions of HSCs              were harvested on Delaware Bay for use as _____
	fertilizer

	
	500 
	Slide 43
	In the United States today, large numbers of  HSCs are used by commercial fisherman as _____  
	bait (for eel or       conch fisheries)

	5th column (HSC Hodge Podge)
	100 
	Slide 45 -Daily Double
	the blood of the HSC appears blue because it contains
	copper

	
	200 
	Slide 48 
	process by which HSCs grow in stages
	molting

	
	300 
	Slide 50
	people have died from using HSCs in this way
	eating them

	
	400 
	Slide 52
	phylum of animals to which HSCs belong
	arthropod

	
	500 
	Slide 54
	highly diverse, long extinct, group of animals that came before HSCs and resembled them in many ways   
	trilobites


 International Horseshoe Crab Double Jeopardy ppt slides set-up information
	Category
	Value
	Hyperlink    takes you to 
	Question
	"What is" Answer

	1st column (the Four Species)
	200 
	 Slide 2
	the most abundant and well-protected of the 4 horseshoe crab (HSC) species 
	Limulus polyphemus

	
	400 
	 Slide 4
	females of this species feature 3 long spines on each side of the opisthosoma
	Tachypleus tridentatus

	
	600 
	 Slide 6 – Daily Double
	produces the largest eggs of the four species
	Tachypleus gigas

	
	800 
	 Slide 9
	practices polyandrous (multiple males fertilizing the eggs of one female) mating strategies 
	Limulus polyphemus 

	
	1000 
	Slide 11         
	species associated with tetradotoxin poisoning  from consumption by humans
	Carcinoscorpius rotundicauda

	2nd column (Where in the World?)
	200 
	 Slide 13
	a museum shaped like and dedicated to the horseshoe crab can be found here  
	Japan

	
	400 
	 Slide 15
	bounties were once offered in this coastal U.S. area for turning in the tails of dead HSCs
	Cape Cod

	
	600 
	 Slide 17
	HSCs are used for bait in the octopus fishery here
	Mexico

	
	800 
	 Slide 19 – Daily Double
	HSCs are celebrated in these countries during Chinese Valentine’s day events
	Hong Kong, Taiwan  and/or China

	
	1000 
	 Slide 22
	Buddhist blessings of horseshoe crab events have been held here each of the last 6 years  
	United States                               (or Delaware Bay)

	3rd column (Structure   & Function)
	200 
	 Slide 24
	these structures enable the HSC to detect UV light for adjusting its sensitivity to light at night
	median eyes

	
	400 
	Slide 26
	female HSCs use these versatile appendages to mold their eggs into clusters 
	pusher legs

	
	600 
	 Slide 28
	photosensors in this structure assist the HSC in maintaining its day/night 24-hour clock
	telson

	
	800 
	 Slide 30
	chitinous spines inside this organ help the HSC break down its food 
	crop-gizzard                          (or proventriculus)

	
	1000 
	 Slide 32
	name for special sensory organ located at the    base of the HSC pusher leg above its gills 
	flabellum

	4th column (HSCs & Humans)
	200 
	 Slide 34
	a few years ago, Asian HSCs were being imported to the United States for use as
	bait for eel or conch (whelk) fisheries 

	
	400 
	 Slide 36 – Daily Double
	over 100 years ago on Delaware Bay, HSC eggs  were shoveled up by the wagonload for use as 
	feed for chickens & hogs

	
	600 
	Slide 39 
	Japanese mythology holds that the spirit of these people are embodied in the shells of HSCs 
	Samurai warriors

	
	800 
	Slide 41 
	in the 1970's, University of Delaware researchers spun chitin filaments from HSCs for use in
	burn wraps and/or  surgical sutures 

	
	1000 
	Slide 43
	an Indian researcher recently discovered potential use of the fluid inside the HSC egg for 
	tissue regeneration therapies

	5th column (Name that Scientist)
	200 
	Slide 45 
	noted for his ground-breaking, Nobel Prize    winning research on horseshoe crab vision
	Dr. Keffer Hartline

	
	400 
	Slide 47 
	renowned world authority (after 60+ years of dedicated study) on Limulus polyphemus
	Dr. Carl Shuster

	
	600 
	Slide 49
	researchers recognized for their extraordinary collaboration on the discovery of LAL
	Dr. Fred Bang &                Dr. Jack Levin

	
	800 
	 Slide 51
	most honored Japanese HSC scientist for lifelong pioneering research on Tachypleus tridentatus
	Dr. Koichi Sekiguchi

	
	1000 
	 Slide 53 – Daily Double
	noted for developing a synthetic, genetically-engineered version of LAL called  'Factor C' 
	Dr. Jeak Ling Ding



Teacher answer key for International HSC Jeopardy (student version) game
	Where in the World?
	By the Numbers
	HSC Parts Smarts
	Horseshoe Uses
	HSC Hodge Podge

	100
are horseshoe crabs called ‘kabutogani’
What is Japan?
	100
[bookmark: _GoBack]number of species of HSCs that exist today  
What is 4?
	100
Nobel Prizes were awarded for research carried out on this part of the HSC anatomy 
What are the lateral eyes   or compound eyes?
	100
much-valued biomedical product from HSC blood 
What is LAL or TAL?
	100           Daily Double!
the blood of the HSC appears blue because it contains 
What is copper?

	200
are the southernmost populations of the American horseshoe crab found
What is Yucatan/Mexico?
	200
number of long spines on female Tachypleus tridentatus 
What is 3?
	200           Daily Double!
structures horseshoe crabs use for respiration
What are the book gills?
	200
HSC eggs on Delaware Bay provide a key resource in supporting the migration of  
What are shorebirds                        (or red knots)?
	200
process by which HSCs          grow in stages
What is molting?

	300
are the eggs of HSCs considered a dining delicacy 
What is Malaysia, Thailand and/or Vietnam?
	300
number of pairs of legs on   a horseshoe crab
What is 5?
	300
scientific term for front section of HSC body 
What is the prosoma?
	300           Daily Double!
LAL makes human medicines safe to use by ensuring that they are not contaminated with 
What are bacterial endotoxins?
	300
people have died from  using HSCs in this way 
What is eating them?

	400
do you need to go to see the largest masses of spawning HSCs on the planet 
What is Delaware Bay, USA?
	400
millions of years HSCs have been living on Earth 
What is 445?  (or 450)
	400
name used for the specially modified hind legs of the HSC 
What are the pusher legs?
	400
from the mid 1800’s to 1900’s, millions of HSCs were harvested on Delaware Bay for use as 
What is fertilizer?
	400
phylum of animals to    which HSCs belong 
What is arthropod?

	500           Daily Double!
are HSCs raised by high school students for release into the wild to help rebuild populations
What is Hong Kong or Taiwan?
	500
years it takes an American HSC to reach adulthood
What is 8-10?
	500
during spawning, eggs (in females) and sperm (in males) are released from the underside of this HSC structure
What is the operculum?
	500
In the U.S. today, large numbers of  HSCs are used by commercial fisherman as 
What is bait for eel or conch (whelk) fisheries?
	500
highly diverse, long extinct, group of animals that came before HSCs and resembled them in many ways   
What are trilobites?


Teacher answer key for International HSC Double Jeopardy (challenging level) game
	The Four Species
	Where in the World?
	Structure & Function
	Human connections
	Name that Scientist

	200
the most abundant and well-protected of the 4 HSC species
What is Limulus polyphemus?
	200
a museum shaped like and dedicated to the horseshoe           crab can be found here  
What is Japan?
	200
these structures enable the HSC to detect UV light for adjusting its sensitivity to light at night
What are the median eyes?
	200
a few years ago, Asian HSCs  were being imported to the United States for use as
What is bait for eel or conch/whelk fisheries?
	200
noted for his ground-breaking, Nobel Prize winning research  on horseshoe crab vision
Who is Keffer Hartline?

	400
females of this species feature    3 long spines on each side of    the opisthosoma
What is Tachypleus tridentatus?
	400
bounties were once offered in this U.S. coastal area  for turning in the tails of dead HSCs
What is Cape Cod (USA)?
	400
female HSCs use these     versatile appendages to mold their eggs into clusters
What are the pusher legs?
	400           Daily Double!
over 100 years ago on Delaware Bay, HSC eggs  were shoveled up by the wagonload for use as
What is feed for chickens or hogs?
	400
renowned world authority    (after 60+ years of dedicated study) on Limulus polyphemus
Who is Dr. Carl Shuster?

	600           Daily Double!
produces the largest eggs of     the four species
What is Tachypleus gigas?
	600
HSCs are used for bait                     in the octopus fishery here
What is Mexico?
	600
photosensors in this structure assist the HSC in maintaining its day/night 24-hour clock
What is the telson?
	600
Japanese mythology holds that the spirit of these people are embodied in the shells of HSCs
What are Samurai warriors?
	600
two researchers recognized for their extraordinary collaboration on the discovery of LAL
Who are Dr. Fred Bang and Dr. Jack Levin?

	800
practices polyandrous (multiple males fertilizing the eggs of one female) mating strategies
What is Limulus polyphemus?
	800           Daily Double!
HSCs are celebrated in these countries during Chinese Valentine’s day events
What is Hong Kong, Taiwan and/or China?
	800
chitinous spines inside this   organ help the HSC break     down its food
What is the crop-gizzard             (or proventriculus)?
	800
in the 1970's, University of Delaware researchers spun chitin filaments from HSCs for use in
What is burn wraps and/or surgical sutures?
	800
most honored Japanese HSC scientist for lifelong pioneering research on T. tridentatus
Who is Dr. Koichi Sekiguchi?

	1000
species associated with tetradotoxin poisoning from consumption by humans
What is Carcinoscorpius rotundicauda?
	1000
Buddhist blessings of horseshoe crab events have been held here each of the last 6 years  
What is Delaware Bay, USA?
	1000
name for special sensory organ located at the base of the HSC pusher leg above its gills
What is the flabellum?
	1000
an Indian researcher recently discovered potential use of the fluid inside the HSC egg for
What is tissue regeneration or organ transplant therapies?
	1000           Daily Double!
noted for developing a synthetic, genetically-engineered version  of LAL called  'Factor C'
Who is Dr. Jeak Ling Ding?




